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About this guide

Who should use this guide
1  About this guide

This Client Desktop Getting Started Guide provides an introduction to the Client 
Desktop application and an overview of its main features.

1.1  Who should use this guide

This guide is intended for contact center staff who are first-time users of the Client 
Desktop application, including front-line agents and associates.

1.2  Formatting conventions

The following formatting conventions are used in this guide:

Bold
This font identifies OpenScape Contact Center components, window and dialog 
box titles, and item names.

Italic
This font identifies references to related documentation.

Monospace Font
This font distinguishes text that you should type, or that the computer displays in 
a message.

NOTE: Notes emphasize information that is useful but not essential, such as tips 
or alternative methods for performing a task. 

IMPORTANT: Important notes draw special attention to actions that could 
adversely affect the operation of the application or result in a loss of data. 
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About this guide

Documentation feedback
1.3  Documentation feedback

To report an issue with this document, call the Customer Support Center.

When you call, be sure to include the following information. This will help identify 
which document you are having issues with.

• Title: Client Desktop Getting Started Guide

• Order Number: A31003-S2281-G101-4-7631
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Getting started

Logging on to the Client Desktop application
2  Getting started

Welcome to the OpenScape Contact Center Client Desktop application, a 
versatile application designed to help you handle contacts from start to finish, 
easily and efficiently. 

The Client Desktop application provides many tools to help you respond to 
contacts, track contact activity, monitor and consult with other users, and quickly 
find the information that you need. 

2.1  Logging on to the Client Desktop application

This section describes how to log on to the Client Desktop application and the 
options that are available to you during the logon process.

NOTE: If your user name for the operating system is configured (in the Manager 
application) to also serve as your Client Desktop user name, you bypass the 
Logon dialog box and start with step 7 below, where you can select automatic 
logon options for the media that you will be working with.

NOTE: In a high availability (warm standby) environment, you must log on using 
the cluster name rather than the server name. For details, see your supervisor.

To log on to the Client Desktop application:

1. On the Start menu, point to Programs, then OpenScape Contact Center 
Enterprise, and then click Client Desktop. The Logon dialog box appears.

2. In the User name box, type your user name.

3. In the Password box, type your password.

4. If you need to change the server connection, click Options, and then in the 
Administration Server box, type the name of the required server machine.

5. If you are working in a multitenant environment, click Options, and then in the 
Business unit box, type the name of the business unit that you want to log 
on to.

6. Click OK.
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Getting started

Working in the main window
7. If the Auto-Logon Options dialog box appears, select the check box for each 
media type that you want to log on to. If the Auto-Logon Options dialog box 
does not appear, the application starts and you skip the remainder of this 
procedure. 

NOTE: The Auto-Logon Options dialog box is not available to SAP CIC users 
working in CRM Agent mode. 

8. If you selected Voice or Callback, in the Extension box, type your extension 
number or select an extension from the list. The same extension number is 
used for both media types.

9. Click OK. The main window appears.

2.2  Working in the main window

When the Client Desktop application starts, the main window appears. The main 
window remains on your screen, in either full or icon mode, for the entire time that 
you work with the application. 

Active Contacts Personal Performance Status bar 
toolbar

Standard

BroadcasterSpeed Bar and 
Team Bar

Dial boxSoftphone Routing Logon/
controls

toolbar

Presence
state

Handling
state
buttons 

state
indicator indicator

Logoff
button 

Feature Post-
processing
button

controls and
indicators

Request 
Assistance
button

Media bar
Bar
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Getting started

Working in the main window
2.2.1  Using the standard toolbar

You can access many commands by using the buttons on the standard toolbar. If 
the standard toolbar does not appear in the main window, you can display it (on 
the View menu, point to Toolbars, and then click Standard).

The buttons on the standard toolbar are grouped according to their function. 

Log on to all media types that you are configured to use.

Log off all the media types that you are logged on to.

Place yourself in Available routing state.

Place yourself in Unavailable routing state.

Place yourself in Work routing state. 

Place yourself in Post-processing handling state. 

Indicates how long you have been in the current handling state. 

Answer a call.

Place a call on hold.

Transfer a call to another user. 

Consult on a call with another user.

Reconnect to the caller.

Conference on a call. 

Display the Contact Details window.

Display the Activity Log.

Display the Directory Search window.

Display the Speed List.

Display the Team List. 

Indicates that all media types that you are configured to use are available.

Indicates that some of the media types are unavailable.

Indicates that all media types are unavailable.

Indicates how long you have been in the current presence state. 

Request assistance from supervisors or managers. 
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Getting started

Working with user states
2.3  Working with user states

Before routing a contact to you, the system checks a number of factors, including 
your user state. 

There are three different types of user states: 

• Routing state – Indicates whether you are able to receive a new contact. The 
routing states are Available, Unavailable, and Work. 

• Handling state – Indicates your activity while handling a contact. Examples 
are Dialing, Talking, and Post-processing. 

• Presence state – Indicates your current presence state. Examples are 
Active, Busy, and Away. 

For example, when you are Available and Talking, the Available button on the 
standard toolbar is selected, the State on the Personal Performance toolbar 
displays Talking, and your presence state is Active. 

2.3.1  About routing states

There are three routing states: Available, Unavailable, and Work. Unavailable 
and Work routing states have reasons associated with them. The ToolTips for the 
Unavailable and Work buttons show the routing state, the current reason, and the 
total time in that state (for example, “Work: Training - 00:45”). 

The following table shows the effect of each routing state on the ability to receive 
routed contacts.

NOTE: No matter which routing state you are in, if your extension is free, another 
user can transfer a call to you or consult with you about a call. 

Button Description

 Available – You are logged on to one of the contact media and you are free 
to receive routed contacts.

 Unavailable – You are logged on to one of the contact media but you are not 
available to handle routed contacts. For example, you might be having lunch 
or taking a break. 

 Work – You are logged on to one of the contact media but you are performing 
a work-related task not associated with a contact, and are not available to 
handle routed contacts. For example, you might be attending a meeting or a 
training session. 

Table 1 Routing states
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Depending on your current routing state and the settings that are enabled for you, 
you can do the following:

• Change your routing state. For details, see Section 2.3.4, “Changing your 
routing state”, on page 13.

• Change the Unavailable or Work reason. For details, see Section 2.3.5, 
“Changing the Unavailable or Work reason”, on page 13. 

2.3.2  About handling states

Handling states provide detailed information about how a contact is being 
handled. The following table describes the main handling states. 

Post-processing handling state has reasons associated with it. The ToolTip for 
the Post-processing button in the Contact Details window shows the state, the 
current reason, and the total time in Post-processing state (for example, 
“Post-processing: Faxing - 00:45”). The ToolTip for the Post-processing button in 
the main window does not show the time. 

Depending on the settings that are enabled for you, the system might 
automatically change your handling state to Post-processing when you 
disconnect from a contact. For details, see Section 2.3.8, “Automatic changes to 
Post-processing handling state”, on page 15.

Handling state Description

Consulting You are consulting with another party about a call or callback. 

Dialing You are dialing from your extension. 

Holding You are handling a call or callback and have placed the call on hold. 

Pending You have been offered a routed contact, however:
• For voice, the telephone is not ringing yet.
• For callback, the offer has not been accepted yet and the 

maximum pending time has not been reached. 
• For e-mail, the message has not been accepted yet. 

Post-processing You are performing tasks related to a routed contact after it has 
been disconnected. For example, you are making notes or sending 
follow-up information. 

Processing You are doing one of the following:
• Previewing a callback request. (You might have already 

accepted the callback offer, but the system has not yet dialed the 
customer's number.)

• Handling a routed e-mail message, or resuming the handling of 
an e-mail message that is in Deferred or Consulted state.

Ringing Your extension is ringing with a call. 

Talking You are talking or conferencing on a call or callback. 

Table 2 Handling states and their meanings
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Depending on your current handling state and the settings that are enabled for 
you, you can do the following: 

• Manually enter Post-processing handling state. For details, see Section 2.3.6, 
“Entering Post-processing handling state”, on page 14. 

• Change the Post-processing reason. For details, see Section 2.3.9, 
“Changing the Post-processing reason”, on page 16.

• Exit Post-processing handling state. For details, see Section 2.3.7, “Exiting 
Post-processing handling state”, on page 14. 

NOTE: The buttons on the telephone indicate your routing state. However, if you 
are handling calls using the telephone only (you are not licensed to use the Client 
Desktop application), and you are in Post-processing handling state, the Work 
button on the telephone will be activated regardless of your routing state. In this 
case, to exit Post-processing handling state, you must press one of the other 
buttons on the telephone, such as Available.

2.3.3  About presence states

Presence states are derived from OpenScape Contact Center information, such 
as your routing state and current contact handling activity. The following table 
describes the presence states. 

Presence state Description

Active You are handling one or more contacts. 

Away You have no active contacts and your routing state is Unavailable. 

Busy You have no active contacts and your routing state is Work. 

Idle You have no active contacts and your routing state is Available. 

Logged Off You are not logged on to any of the media types. 

Table 3 Presence states and their meanings
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2.3.4  Changing your routing state

When you are logged on to at least one of the contact media, you can change 
your routing state. You might want to change your routing state when, for 
example:

• You just logged on to one of the contact media and you want to start receiving 
contacts. In this case, change your routing state to Available.

• You are logged on to one of the contact media but do not want to receive 
contacts. In this case, change your routing state to Unavailable.

• You are logged on to one of the contact media but you have to attend a short 
meeting. In this case, change your routing state to Work. 

To change your routing state:

1. In the main window, on the Actions menu, click the required routing state: 
Available, Unavailable or Work. 

As a shortcut, you can click the Available button , Unavailable button , 
or Work button  on the standard toolbar. 

If you have multiple active contacts, you can also change your routing state 
from the Actions menu in the Active Contacts List. 

2. If you selected Unavailable or Work, and user-defined Unavailable or Work 
reasons have been configured in the Manager application, the Unavailable 
Reason dialog box or the Work Reason dialog box appears. In the Name list, 
select a reason, and then click Select. 

As a shortcut, you can click the down-arrow that appears beside the button, 
and select one of the most recently used reasons from the list.

2.3.5  Changing the Unavailable or Work reason

When you are in Unavailable or Work routing state, you can change your reason 
for being in that state, provided that user-defined reasons have been configured 
in the Manager application.

To change the Unavailable or Work reason:

1. In the main window, click the Unavailable button  or the Work button . 

2. In the Unavailable Reason dialog box or the Work Reason dialog box, 
select a reason from the Name list, and then click Select. 

As a shortcut, you can click the down-arrow that appears beside the button, 
and select one of the most recently used reasons from the list.
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2.3.6  Entering Post-processing handling state

If the Automatic Post-processing setting is enabled for you in the Manager 
application, you will enter Post-processing handling state automatically when you 
disconnect from a contact. If the Automatic Post-processing setting is not 
enabled for you, and you have the Manually enter Post-processing state and 
change reason permission, you can choose to enter Post-processing handling 
state after you disconnect from a contact. When you choose to enter Post-
processing handling state in this way, the Post-processing button will flash and 
the ToolTip will indicate that the state change is pending, for example, "Pending 
Post-processing (Faxing)", until you disconnect from the contact. 

If you place yourself in Post-processing handling state, rather than the system 
placing you in that state, you will remain in Post-processing handling state until 
you choose to exit Post-processing handling state. 

To enter Post-processing handling state:

1. Do one of the following:

• In the Contact Details window, on the Actions menu, click Enter Post-
processing. 

• If the Contact Details window is not open, in the main window, on the 
Actions menu, click Enter Post-processing. 

As a shortcut, you can click the Post-processing button  on the toolbar. 

2. If user-defined Post-processing reasons have been configured in the 
Manager application, the Post-processing Reason dialog box appears. In 
the Name list, select a reason, and then click Select. 

As a shortcut, you can click the down-arrow that appears beside the button, 
and select one of the most recently used reasons from the list. 

2.3.7  Exiting Post-processing handling state

You can exit Post-processing handling state whenever you choose.

NOTE: The buttons on the telephone indicate your routing state. However, if you 
are not configured to use the Client Desktop application, and you are in Post-
processing handling state, the Work button on the telephone will be activated 
regardless of your routing state. In this case, to exit Post-processing handling 
state, you can press one of the other buttons, such as Available.
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To exit Post-processing handling state:

1. Do one of the following:

• In the Contact Details window, on the Actions menu, click Exit Post-
processing. 

• If the Contact Details window is not open, in the main window, on the 
Actions menu, click Exit Post-processing. 

As a shortcut, you can click the Post-processing button  on the toolbar. 

2.3.8  Automatic changes to Post-processing 
handling state

If the Automatic Post-processing setting has been enabled for you in the 
Manager application, the system places you in Post-processing handling state 
after you disconnect from a contact. When the system places you in Post-
processing handling state, rather than you placing youself in that state, you do not 
have to specify a Post-processing reason.

In combination with the Automatic Post-processing setting, the following 
settings might also be configured: 

• Maximum time – You will remain in Post-processing handling state for the 
duration of time specified. 

• Wrap-up reason required – The system opens the Wrap-up tab in the 
Contact Details window and you must save at least one Wrap-up reason to 
explain how you completed the contact. If you save a Wrap-up reason before 
the specified Maximum time has passed, you will remain in Post-processing 
handling state until the Maximum time expires. If you do not save a Wrap-up 
reason before the specified Maximum time has passed:

– For calls, e-mail messages, and Web collaboration contacts, you will 
remain in Post-processing handling state until you save a Wrap-up 
reason.

– For callbacks, the system considers the Maximum time to enter result 
option. When this period of time expires, the system enters a Retry 
reason, and then closes the Contact Details window and requeues the 
callback.
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2.3.9  Changing the Post-processing reason

If the Manually enter Post-processing state and change reason permission is 
enabled for you in the Manager application, and user-defined Post-processing 
reasons have been configured, you can select a different reason for being in 
Post-processing handling state. 

To change the Post-processing reason:

1. In the Contact Details window, or in the main window if the Contact Details 
window is not open, click the down-arrow beside the Post-processing button 

. A drop-down list appears.

NOTE: Do not click the button. If you click the button rather than the arrow 
beside the button, you will exit Post-processing handling state. 

2. If the list contains at least one recently used Post-processing reason, you can 
select a reason from the list. Otherwise, click Other to open the Post-
processing Reason dialog box, select a reason from the Name list, and then 
click Select. 
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2.4  Working in the Contact Details window

The Contact Details window is the standard Client Desktop interface for handling 
all types of routed contacts. The title bar of the Contact Details window shows the 
time that the contact arrived. The Information Banner shows the status of the 
contact. 

Four tabs appear in the Contact Details window for all active contacts.

• Details tab – displays information about the customer and the queue. 

• Contact Data tab – displays information about the contact (for example, 
account number). 

• Directory tab – displays any available contact information about the 
customer. 

• Wrap-up tab – offers options for completing the contact. 
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Other tabs that might appear, depending on the contact type, are as follows: 

• Schedule tab – for callbacks, used to review and plan callback schedule 
items. 

• Message tab – for e-mail messages, used to view the customer’s message 
and to reply to it.

• History tab – for e-mail messages, used to view the history of e-mail 
messages sent to or from the customer. 

• Session tab – for Web collaboration contacts, used to view the customer’s 
message or to reply to it. S

2.4.1  Viewing information on the Details tab

The Details tab in the Contact Details window contains information about the 
contact (for example, source, destination, routing queue, answering user). 

Regardless of the type of contact you are handling, you can use the Details tab 
to do the following:

• View information about the contact.

• Change the description of the contact.

• Access supplemental information to help you handle the contact. 

2.4.2  Updating information on the Contact Data tab

The Contact Data tab in the Contact Details window is used to record information 
about the contact that is relevant, such as the customer's account number, 
preferences, payment details, and so on. You can update information on the 
Contact Data tab only while you are connected to the contact.

OpenScape Contact Center might insert information on the Contact Data tab 
before the contact reaches you, for example, by collecting information in 
response to menu prompts or by retrieving information from a database. This 
depends on the workflow that is designed in the Manager application.

To update information on the Contact Data tab:

1. On the Contact Data tab, under Key, on the last line, type the kind of 
information you want to add (for example, Shipping Preference). Each key 
must be unique. 

2. Under Value, type the information (for example, By Rail).

3. On the File menu, click Save.
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2.4.3  Viewing information on the Directory tab

When a new contact is routed to you, the system automatically searches the 
Contact Lookup Directory for any entries that match the customer's information 
on the Details tab. The results of the search are displayed on the Directory tab. 
This information is read-only. 

2.4.4  Completing a contact on the Wrap-up tab

Use the Wrap-up tab in the Contact Details window to explain how you completed 
a contact.

• To complete a call, see Section 3.5, “Wrapping up a call”, on page 28.

• To complete a callback, see Section 4.6, “Wrapping up a callback”, on page 
33.

• To complete an e-mail message, see Section 5.4, “Wrapping up an e-mail 
message”, on page 40.

• To complete a Web collaboration session, see Section 6.5, “Wrapping up a 
Web collaboration session”, on page 46.

2.5  Working with multiple contacts

When the system is configured for multiple contact handling, the contact handling 
rules that have been configured for you in the Manager application determine 
whether you can handle more than one routed contact at the same time. If you 
have been configured to handle multiple routed contacts, the system's routing 
logic takes your contact handling rules into account to determine your availability. 
To find out how many contacts of each type you have been configured to handle 
at one time, contact your manager or supervisor. 

When you have more than one active contact, you can use the Active Contacts 
List or the Active Contacts Bar to manage your active contacts. 

2.5.1  Using the Active Contacts List

When you have been configured to handle multiple routed contacts, all your 
active contacts are displayed in the Active Contacts List. The Active Contacts List 
can be displayed in the following modes: 

• List mode – The active contacts are listed in a table. 

• Card mode – A card is displayed for each active contact. The cards are color-
coded. 
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When you click an active contact in the list, its Contact Details window is 
displayed. You can navigate between active contacts in this way, and also by 
using the keyboard shortcuts. 

When you receive a new contact, the system inserts the new contact into the 
Active Contacts List based on your sorting preferences. New active contacts are 
highlighted in the list until the first time you view a contact’s Contact Details 
window. 

For reporting purposes, the system keeps track of the active contact that is 
primary. The primary contact is normally the active contact that is in focus in the 
Client Desktop application. The one exception to this rule is when the Always 
make the active call or callback the primary contact option is configured in the 
Manager application. In this case, when you have an active call or callback, it 
remains the primary contact even if you choose to work on another active contact.

When you complete the primary contact, the system selects the first active 
contact in the list, which is based on your sorting preferences. If the Always make 
the active call or callback the primary contact option is configured and you 
subsquently receive a call or callback, it automatically becomes the primary 
contact. 

To view the Active Contacts List:

• On the View menu, click Active Contacts List.

2.6  Displaying or hiding the Contacts Waiting Indicator

The Contacts Waiting Indicator  displays the number of contacts that are 
waiting in queue to be handled. The number includes both contacts that you are 
eligible to handle and contacts that are reserved for you. 

By default, the Contacts Waiting Indicator is displayed in the notification area on 
the right side of the Windows taskbar. You can also add the Contacts Waiting 
Indicator to a toolbar. 

NOTE: When the system is connected to a HiPath 4000 or HiPath 3000 
communication platform, if you are not logged on to the Client Desktop 
application and your telephone has been configured to display the Contacts 
Waiting Indicator, the Contacts Waiting lamp indicator on the telephone will notify 
you when there are contacts waiting in the queue. The Contacts Waiting lamp 
indicator on the telephone is turned off when you are logged on to the Client 
Destkop application.
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The Contacts Waiting Indicator provides information in two ways:

• When you rest the mouse pointer on the Contacts Waiting Indicator, the 
ToolTip displays the number of contacts waiting, by contact type. 

• The Contacts Waiting Indicator changes its state as the number of contacts 
increases. The indicator has four states: off, on, slow flash, and fast flash. 
These states correspond to thresholds that can be set in the Manager 
application. As the number of contacts waiting increases and passes each 
threshold, the indicator moves through the different states.

– Off – minimum threshold has not been passed.

– On – minimum threshold has been passed.

– Slow flash – middle threshold has been passed.

– Fast flash – highest threshold has been passed.

If you are handling contacts in two or more media, the state of the Contacts 
Waiting Indicator is based on the highest threshold that has been passed. For 
example, if the number of calls waiting indicates a slow flash condition and the 
number of e-mail messages waiting indicates a fast flash condition, the Contacts 
Waiting Indicator shows a fast flash.

To display or hide the Contacts Waiting Indicator:

1. On the Tools menu, click Options.

2. In the Options dialog box, in the left pane, click Personal.

3. Under Show, select or clear the Contacts Waiting Indicator in notification 
area check box.

4. Click OK.

2.7  Requesting assistance

If you need help while you are handling a contact, you can request assistance 
from your supervisors or managers. 

NOTE: To initiate a request for assistance, the Request assistance permission 
must be enabled for you in the Manager application. 
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2.7.1  Initiating a request for assistance

When you initiate a request for assistance, it sets a flag in a user real-time report 
that can be viewed by all the supervisors and managers who have permission to 
monitor you. 

When you log off all media that you are logged on to, the request is cancelled. 
You can also cancel a request manually. For details, see Canceling a request for 
assistance. 

NOTE: To initiate a request for assistance, the Request assistance permission 
must be enabled for you in the Manager application. 

To initiate a request for assistance:

1. Do one of the following:

• In the Contact Details window, on the Actions menu, click Request 
Assistance. 

• If the Contact Details window is not open, in the main window, on the 
Actions menu, click Request Assistance. 

As a shortcut, you can click the Request Assistance button  on the 
toolbar. 

2.7.2  Canceling a request for assistance

You can cancel a request for assistance when you no longer need help. 

To cancel a request for assistance:

1. Do one of the following:

• In the Contact Details window, on the Actions menu, click Cancel 
Assistance. 

• If the Contact Details window is not open, in the main window, on the 
Actions menu, click Cancel Assistance. 

As a shortcut, you can click the Cancel Assistance button  on the toolbar.
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3  Handling calls

The voice feature in the Client Desktop application is a licensed feature that helps 
you handle and track routed calls. This chapter provides an overview of how calls 
are handled in the Client Desktop application.

3.1  Logging on to voice

To handle calls, you must log on to voice and to an extension, and then change 
your routing state to Available. 

NOTE: If you are already logged on to callback, the system does not prompt you 
for another extension number when you log on to voice. The same extension 
number is used for both the voice and callback media.

To log on to voice:

1. In the main window, on the Actions menu, point to Logon/Logoff, then 
Voice, and then do one of the following: 

– To log on to a recently used extension, click one of the numbers in the list. 
The system displays the last five numbers that you used.

– To log on to a new extension, click New, and then in the Logon dialog 
box, type the extension number and click .

If this is the first of the contact media that you are logging on to, a red arrow 
appears on the left side of the Logon button . This shows that you are 
connected to at least one of the contact media.

2. On the toolbar, either the Available button or the Unavailable button is 
selected. To receive contacts, you must be in Available routing state. To 
change your routing state, see Section 2.3.4, “Changing your routing state”, 
on page 13. 

3.2  Answering a call

Use this procedure to answer a call that is routed or transferred to your extension, 
or requeued to you. 

To answer a call:

• In the Contact Details window, on the Actions menu, click Answer. As a 
shortcut, you can click the Answer button  on the toolbar.
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3.3  Responding to a call

This section describes some of the ways in which you can handle calls.

3.3.1  Placing a call on hold and retrieving it

You can place a call on hold if you need to investigate an issue before continuing 
the conversation with the caller.

To place a call on hold:

• In the Contact Details window, on the Actions menu, click Hold. As a 
shortcut, you can click the Hold button  on the toolbar. 

To retrieve a call that is on hold:

• In the Contact Details window, on the Actions menu, click Retrieve. As a 
shortcut, you can click the Retrieve button  on the toolbar. 

3.3.2  Consulting with another user on a call

If you intend to consult with another user about a call, the consulting feature in the 
Client Desktop application is a more flexible option than placing the call on hold 
yourself and then dialing the number of the other user. 

When you place a call on hold yourself, the call remains on hold until you either 
retrieve the call or disconnect from the call. On the other hand, if you initiate a 
consultation with another user while you are on a call, the system automatically 
places the call on hold, and then you have the following options:

• Transfer the call to the user you are consulting with. For details, see Section 
3.3.3, “Transferring a call”, on page 25

• Bring the caller into a conference call with yourself and the other user. For 
details, see Section 3.3.4, “Conferencing on a call”, on page 27.
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To consult with another user on a call:

1. While you are connected to a call, in the Contact Details window, on the 
Actions menu, point to Consult, and then do one of the following:

• Point to the list of telephone numbers that you want to use (Recently 
Used, Team Bar, or Speed Bar) and then click a telephone number.

• Click New Number. In the Consult With dialog box, do one of the 
following:

– In the Telephone number box, type a telephone number or select a 
telephone number from the list.

– To use the Dial Entry dialog box, click . In the Dial Entry dialog 
box, make your changes, and then click OK. 

– To select a name from a list, click More. The Agents tab and the 
Team List tab show all the users in the contact center and on your 
team, respectively, who are logged on to voice or callback. Double-
click the name of the user with whom you want to consult. The user's 
extension is inserted into the Telephone number box.

2. Click . The system dials the number and automatically places the call on 
hold.

To reconnect to the customer:

• On the Actions menu, click Reconnect.

3.3.3  Transferring a call

You can transfer a call to another user. This is often a team member, and often 
someone whom you already consulted about the contact. Use the Actions menu 
in either the Contact Details window or the Directory Search window to transfer a 
call.

You can transfer a call to another user in two ways:

• Supervised transfer

• Unsupervised transfer 
A31003-S2281-G101-4-7631
OpenScape Contact Center Enterprise V8 R2, Client Desktop Getting Started Guide 25

         

, May 2012



Handling calls

Responding to a call
3.3.3.1  Making a supervised transfer

While you are consulting with another user, you can transfer a call to that user. 
This type of transfer is referred to as a supervised transfer, because it gives you 
the opportunity to tell the other user about the call before you transfer the call.

To transfer a call to a user while you are consulting with that user:

• In either the Contact Details window or the Directory Search window, on the 
Actions menu, click Transfer. The system transfers the call to the other user 
and automatically disconnects you from the call.

3.3.3.2  Making an unsupervised transfer

You can transfer a call to another user even when you are not consulting with the 
other user. This type of transfer is referred to as an unsupervised transfer, 
because it does not give you the opportunity to tell the other user about the call 
before you transfer the call.

To transfer a call when you are not consulting with the other user:

1. In either the Contact Details window or the Directory Search window, on the 
Actions menu, point to Transfer, and then do one of the following:

• Click the telephone number to use.

• Point to one of the lists (Recently Used, Team Bar, or Speed Bar) and 
then click a telephone number.

NOTE: When you click a telephone number or extension on the Team 
Bar, the Client Desktop application dials the number immediately.

• Click New Number. In the Transfer To dialog box, do one of the 
following:

– In the Telephone number box, type a telephone number or select a 
telephone number from the list.

– To use the Dial Entry dialog box, click . In the Dial Entry dialog 
box, make your changes, and then click OK. 

– To select a name from a list, click More. The Agents tab and the 
Team List tab show all the users in the contact center and on your 
team, respectively, who are logged on to voice or callback. Double-
click the name of the user to whom you want to transfer the call. The 
user's extension is inserted into the Telephone number box.
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• If the system is connected to an OpenScape Voice communication 
platform, and you want to transfer the call to the user's voice mail, select 
the Voice Mail check box.

2. Click . The system transfers the call to the other user, and disconnects you 
from the call.

3.3.4  Conferencing on a call

If you are consulting with another user about a call, you can bring the customer 
into the conversation (that is, create a conference call).

To conference on a call:

• In the Contact Details window, on the Actions menu, click Conference. You 
are now conferencing with the customer and the other user.

At the end of the conference call, the usual procedure is:

1. The other user disconnects and the customer hangs up (in either order).

2. You disconnect from the call (on the Actions menu, click Disconnect).

3.4  Disconnecting from a call

When you finish handling a call, you can disconnect from the call. If you are the 
only user participating in the call, the call ends when you disconnect. If you are in 
a conference call with the customer and another user, the call continues when 
you disconnect.

To disconnect from a call:

• In the Contact Details window, on the Actions menu, click Disconnect. As 
a shortcut, you can click the Disconnect button  on the toolbar. 

If the Wrap-up reason required setting is enabled for you, the system 
automatically opens the Wrap-up tab and changes your routing state to Work. 
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3.5  Wrapping up a call

Use the Wrap-up tab in the Contact Details window to enter Wrap-up reasons, to 
show how you completed a call. 

You can enter Wrap-up reasons:

• While you are handling the call.

• After you disconnect from the call, provided that the Contact Details window 
remains open.

• After you close the Contact Details window, provided that you did not 
disconnect from the call.

If the Wrap-up reason required setting is enabled for you in the Manager 
application, you must select at least one Wrap-up reason. 

IMPORTANT: You do not have to wait until you finish handling the contact to 
enter Wrap-up reasons. You can select one or more Wrap-up reasons at any 
time. However, do not save the Wrap-up reasons until you have completed the 
contact, because you can perform only one Save action for Wrap-up reasons. 
After the Save action, you cannot enter any more Wrap-up reasons. 

To wrap up a call:

1. In the Contact Details window, click the Wrap-up tab.

2. Select the check box for each Wrap-up reason that applies to the contact. 
Only Wrap-up reasons that are associated with the contact's queue are 
displayed.

3. On the File menu, click Save.
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4  Handling callbacks

The callback feature in the Client Desktop application is a licensed feature that 
helps you handle and track callbacks. This chapter provides an overview of how 
callbacks are handled in the Client Desktop application.

A callback is a request to call a customer, and is usually based on the customer's 
previous interaction with the contact center. When a callback is accepted, either 
by you or by the system on your behalf, the system calls the customer. The call 
is then routed to you. 

When you handle a callback, you can take all the same types of actions (for 
example, placing a call on hold, consulting, transferring, conferencing) that you 
would take on a call. In addition, there are a few actions that are specific to 
callbacks. For example, you can accept or delete a callback, and retry a callback 
after you disconnect.

4.1  Logging on to callback

To handle callbacks, you must log on to callback and to an extension, and then 
change your routing state to Available. 

NOTE: If you are already logged on to voice, the system does not prompt you for 
another extension number when you log on to callback. The same extension 
number is used for both the voice and callback media. 

To log on to callback:

1. In the main window, on the Actions menu, point to Log on/off, then 
Callback, and then do one of the following:

– To log on to a recently used extension, click one of the numbers in the list. 
The system displays the last five numbers that you used.

– To log on to a new extension, click New, and then in the Logon dialog 
box, type the extension number and click .

If this is the first of the contact media that you are logging on to, a red arrow 
appears on the left side of the Logon button . This shows that you are 
connected to at least one of the contact media.

2. On the toolbar, either the Available button or the Unavailable button is 
selected. To receive contacts, you must be in Available routing state. To 
change your routing state, see Section 2.3.4, “Changing your routing state”, 
on page 13.
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4.2  Accepting or deleting a callback request

When a callback request is queued to you, the Contact Details window appears 
on the screen. The title bar of the window indicates that this is an active contact 
and displays the time that you received the contact.

To accept a callback request:

• In the Contact Details window, on the Actions menu, click Accept 
Callback. The system automatically dials the callback number for you.

To delete a callback request:

1. In the Contact Details window, on the Actions menu, click Delete Callback. 
The Delete Callback dialog box opens.

2. In the Delete Callback dialog box, select a reason from the Delete Reason 
list to explain why you deleted the callback.

3. Click OK.

4. On the File menu, click Save and Close.

4.3  Responding to a callback

You respond to a callback in the same way that you respond to a call. For details, 
see the following topics:

• Section 3.3.1, “Placing a call on hold and retrieving it”, on page 24

• Section 3.3.2, “Consulting with another user on a call”, on page 24

• Section 3.3.3, “Transferring a call”, on page 25

• Section 3.3.4, “Conferencing on a call”, on page 27

4.4  Working with callback schedule entries

When you handle a callback, or when you create a new callback request, you 
might need to add new schedule entries or make changes to existing schedule 
entries. For example, when you are handling a callback, the customer might ask 
you to call again at another time.
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Use the Schedule tab in the Contact Details window to work with callback 
schedule entries. 

The Schedule tab has two main areas:

• Callback Schedule – The Callback Schedule contains entries showing when 
the customer should be called. The entries in the Callback Schedule are 
future, planned callbacks. Each entry includes a date and time, and the 
customer’s telephone number.

• Attempt Log – The Attempt Log contains entries showing when the customer 
was called. These entries are completed callback attempts. Each entry shows 
the name of the user who made the attempt, and the result.
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4.5  Disconnecting from a callback

When you finish handling a callback, you can disconnect from the callback. If you 
are the only user participating in the callback, the callback ends when you 
disconnect. If you are in a conference call with the callback and another user, the 
callback continues when you disconnect.

After you disconnect from the callback, the Retry Options dialog box appears, and 
you have a limited amount of time to select a Retry option. A maximum number 
of retries can be set for callbacks in the Manager application. The type of Retry 
option that you select depends on whether the maximum number of retries has 
been reached for the callback. 

To disconnect from a callback:

1. In the Contact Details window, on the Actions menu, click Disconnect. The 
Retry Options dialog box appears. 

2. If the maximum number of retries has been reached, do one of the following:

• To mark the retry as successful, click Mark as successful. If the Wrap-
up reason required setting is enabled for you in the Manager 
application, the Wrap-up tab opens and you can select a Wrap-up reason 
for the callback.

• To indicate that the maximum number of retries has been reached, click 
Mark as maximum retry reached. When this option is selected, it is not 
necessary to enter a Wrap-up reason.

3. If the maximum number of retries has not been reached, do one of the 
following:

• To mark the retry as successful, click No, the callback was successful. 
If the Wrap-up reason required setting is enabled for you in the Manager 
application, the Wrap-up tab opens and you can select a Wrap-up reason 
for the callback.

• To retry the callback later, click Retry later, and then do the following:

– In the Reason box, select a reason from the list.

– In the Retry in box, type or use the arrows to enter the amount of time 
to wait before retrying the callback, for example, 00:05 (5 minutes) or 
02:30 (2 hours and 30 minutes).

When you select Retry later, the system does not save any Wrap-up 
reasons that you entered. 

• To retry the callback now, click Retry now. If you want to enter or change 
the telephone number, in the Retry number box, type a new number. 

4. Click OK.
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4.6  Wrapping up a callback

Use the Wrap-up tab in the Contact Details window to enter Wrap-up reasons, to 
show how you completed a callback.

If the Wrap-up reason required setting is enabled for you in the Manager 
application, you must select at least one Wrap-up reason. 

IMPORTANT: You do not have to wait until you finish handling the contact to 
enter Wrap-up reasons. You can select one or more Wrap-up reasons at any 
time. However, do not save the Wrap-up reasons until you have completed the 
contact, because you can perform only one Save action for Wrap-up reasons. 
After the Save action, you cannot enter any more Wrap-up reasons. 

To wrap up a callback:

1. In the Contact Details window, click the Wrap-up tab.

2. Select the check box for each Wrap-up reason that applies to the contact. 
Only Wrap-up reasons that are associated with the contact's queue are 
displayed.

3. On the File menu, click Save.
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5  Handling e-mail messages

The e-mail feature in the Client Desktop application is a licensed feature that 
helps you handle and track e-mail messages. This chapter provides an overview 
of how e-mail messages are handled in the Client Desktop application. 

NOTE: When handling e-mail messages in the Client Desktop application, the 
From, To, and Cc address boxes can contain a maximum of 80 entries. 

5.1  Logging on to e-mail 

To handle e-mail messages, you must log on to e-mail, and then change your 
routing state to Available.

To log on to e-mail:

1. In the main window, on the Actions menu, point to Logon/Logoff, and then 
click E-mail.

If this is the first of the contact media that you are logging on to, a red arrow 
appears on the left side of the Logon button . This shows that you are 
connected to at least one of the contact media.

2. On the toolbar, either the Available button or the Unavailable button is 
selected. To receive contacts, you must be in Available routing state. To 
change your routing state, see Section 2.3.4, “Changing your routing state”, 
on page 13.
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5.2  Receiving an e-mail message

When an e-mail message is assigned to you, the Contact Details window appears 
on the screen. The title bar of the window indicates that this is an active contact 
and displays the time that you received the contact. 

The Contact Details window is used very much like an ordinary e-mail program. 
For example, you can reply to or forward a message. 
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5.3  Responding to an e-mail message

This section describes some of the ways in which you can handle e-mail 
messages.

5.3.1  Replying to an e-mail message

When you reply to an e-mail message, you can do one or more of the following:

• Type a reply.

• Use an auto-suggestion, if one has been inserted. 

• Use a prepared template.

To reply to an e-mail message:

1. In the Contact Details window, on the Actions menu, click Reply. (If the 
message contains an auto-suggestion, it is already in Reply mode.)

2. To change the format of your reply, on the Format menu, select the format 
that you want to use: Plain Text or HTML.

3. To see the Cc, Bcc, Subject, or Attachment boxes, on the View menu, click 
the appropriate item.

4. To specify who to reply to, do one of the following:

• In the To, Cc, or Bcc box, type an e-mail address.

• To select an e-mail address from a directory, click To, Cc, or Bcc, and use 
the Select Recipients dialog box.  

NOTE: To enter multiple e-mail addresses in the To, Cc, and Bcc boxes, 
separate each e-mail address with a semicolon (;).

5. To compose a reply to the customer, do one or more of the following:

• Type a reply above the original message.

• Use an auto-suggestion, if one has been inserted. 

• Insert a prepared template and edit it as necessary. 

6. On the Actions menu, click Send.

7. If you are in training mode, the Select Queue dialog box appears. When you 
are in training mode (as specified in the Manager application), you must send 
your reply to a destination where someone can approve it. In the Select 
Queue dialog box, select the queue that you want to send the message to, 
and then click OK. 
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5.3.2  Forwarding an e-mail message to another user

You can forward an e-mail message to another user in the contact center. An 
e-mail message can be forwarded to only one user, and there are no Cc or Bcc 
addresses on an internally forwarded message.

Any attachments that are included in the original e-mail message are 
automatically added to the forwarded message.

To forward an e-mail message to another user:

1. In the Contact Details window, on the Actions menu, click Forward.

2. To specify the user to whom you want to forward the e-mail message, do one 
of the following: 

• In the To box, type the name or e-mail address of the user.

• To select a name from a list of recently used recipients, click the down 
arrow on the right side of the To box, and then click a name in the list. 

• To select a name from the Select Agent dialog box, click To. The Agents 
tab and the Team List tab show all the users in the contact center and on 
your team, respectively, who are logged on to e-mail. Click a user name, 
and then click OK. 

3. On the Actions menu, click Send.

5.3.3  Consulting externally on an e-mail message

You can consult with someone who is outside the contact center. Any 
attachments that are included in the original e-mail message are automatically 
added to the consulting message.

When you consult externally on an e-mail message, the e-mail message is 
assigned a status of Consulted and is added to the Ongoing Activity Log. When 
you are ready, you can resume handling the e-mail message.

NOTE: The reply to an externally consulted e-mail message is always reserved 
for the user who requested the consultation. A contact that is reserved for a user 
will be routed to that user ahead of all other contacts regardless of their priority in 
the queue. 
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To consult externally on an e-mail message:

1. In the Contact Details window, on the Actions menu, click Consult 
Externally.

2. To see the Cc, Bcc, Subject, or Attachment boxes, on the View menu, click 
the appropriate item. 

3. To specify who to consult with, do one of the following:

• In the To, Cc, or Bcc box, type an e-mail address.

• To select an e-mail address from a directory, click To, Cc, or Bcc, and use 
the Select Recipients dialog box. 

NOTE: To enter multiple e-mail addresses in the To, Cc, and Bcc boxes, 
separate each e-mail address with a semicolon (;).

4. On the Actions menu, click Send.

5.3.4  Deferring an e-mail message

If you prefer to handle an e-mail message at a later time, you can defer the 
message. When you defer an e-mail message, the message is assigned a status 
of Deferred and is added to the Ongoing Activity Log. When you are ready, you 
can resume handling the e-mail message. 

If you do not resume handling an e-mail message within a certain period of time, 
the message is requeued to you. This time is specified in the Manager application 
by the following option: Maximum defer time. For example, if the maximum defer 
time is 8 hours, you can defer an e-mail message once for 8 hours, or you can 
defer it for 4 hours, then for 3 hours, and then again for 1 hour. 

To defer an e-mail message:

• In the Contact Details window, on the Actions menu, click Defer.

5.3.5  Resuming an e-mail message in Deferred or 
Consulted state

All your outstanding e-mail messages are saved in the Ongoing Activity Log. 
Outstanding messages are messages that you have either deferred or consulted 
with an external person about. You can resume handling an e-mail message at 
any time, directly from the Ongoing Activity Log.

To resume handling an e-mail message, you must be logged on to e-mail. Also, 
there cannot be another active e-mail message open on your screen.
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To resume handling an e-mail message:

1. In the Ongoing Activity Log, click the message that you want to resume.

2. On the Actions menu, click Resume.
5

5.4  Wrapping up an e-mail message

Use the Wrap-up tab in the Contact Details window to enter Wrap-up reasons, to 
show how you completed an e-mail message. 

If the Wrap-up reason required setting is enabled for you in the Manager 
application, you must select at least one Wrap-up reason. 

IMPORTANT: You do not have to wait until you finish handling the contact to 
enter Wrap-up reasons. You can select one or more Wrap-up reasons at any 
time. However, do not save the Wrap-up reasons until you have completed the 
contact, because you can perform only one Save action for Wrap-up reasons. 
After the Save action, you cannot enter any more Wrap-up reasons. 

If you decide to defer an e-mail message or to consult on the e-mail message, the 
system does not save any Wrap-up reasons that were entered.

To wrap up an e-mail message:

1. In the Contact Details window, click the Wrap-up tab.

2. Select the check box for each Wrap-up reason that applies to the contact. 
Only Wrap-up reasons that are associated with the contact's queue are 
displayed.

3. On the File menu, click Save.
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6  Handling Web collaboration sessions

The Web collaboration feature in the Client Desktop application is a licensed 
feature that helps you handle and track Web collaboration sessions. This chapter 
provides an overview of how Web collaboration contacts are handled in the Client 
Desktop application.

A Web collaboration session is an online, real-time conversation between a 
customer and one or more contact center users. A Web collaboration session is 
initiated by a customer, who typically enters a question or a request in an online 
form. Each company or contact center defines its own form and specifies the type 
of information to be entered.

6.1  Logging on to Web collaboration

To handle Web collaboration sessions, you must log on to Web collaboration, and 
then change your routing state to Available.

To log on to Web collaboration:

1. In the main window, on the Actions menu, point to Logon/Logoff, and then 
click Web Collaboration.

If this is the first of the contact media that you are logging on to, a red arrow 
appears on the left side of the Logon button . This shows that you are 
connected to at least one of the contact media.

2. On the toolbar, either the Available button or the Unavailable button is 
selected. To receive contacts, you must be in Available routing state. To 
change your routing state, see Section 2.3.4, “Changing your routing state”, 
on page 13.
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6.2  Receiving a Web collaboration contact

When a Web collaboration session is assigned to you, the Contact Details 
window appears on the screen, displaying the original question sent by the 
customer and any replies that were sent by the system. The title bar of the window 
indicates that this is an active contact and displays the time that you received the 
contact. 

The Session tab has two main areas:

• Transcript of the session – The transcript shows all the messages sent to 
and received from the Web collaboration contact during the session. The 
transcript is in read-only mode, but you can copy portions and paste them 
elsewhere, or save or print them. 

• Work area – Use this area to reply to a Web collaboration contact. For 
example, you can insert and then edit a standard message, type your own 
reply, and insert URLs. 
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6.3  Responding to a Web collaboration contact

This section describes some of the ways in which you can handle a Web 
collaboration contact.

6.3.1  Typing a message into a Web collaboration 
session

When the Contact Details window appears on your screen, you are in reply mode 
and can begin your response to the contact.

There are many options available for replying to a Web collaboration contact, but 
occasionally you might prefer to type your own message.

To type a message to send to a contact:

1. In the Contact Details window, on the Session tab, type the text of the 
message in the work area in the lower part of the tab.

• To go to the next line in the message, press ALT+ENTER on the 
keyboard.

• You can type a maximum of approximately 1900 characters. The field 
maximum is actually 2000 characters, but that includes the HTML code 
required for formatting. 

2. Click Send. Sending the message is the default action on the Session tab. 
When the message is ready to be sent, you can simply press ENTER.

6.3.2  Inserting a standard message into a Web 
collaboration reply

When you reply to a Web collaboration contact, you can save time by using a 
standard message. You can insert either a generic message or a message 
associated with the current queue, and then edit the message to meet your 
requirements.

To insert a standard message into a Web collaboration session:

1. In the Contact Details window, on the Insert menu, click Insert Message. 

2. In the Insert Message dialog box, under Template, select a message. You 
can preview the message under Message Preview.  

3. Click Insert. The message is inserted into the work area, at the cursor 
position.
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4. Click Close.

NOTE: As a shortcut, you can click Insert Message on the toolbar above the 
work area, and then select the message from the list.

6.3.3  Inserting an emoticon into a Web collaboration 
message

Emoticons, such as a happy face, are often used in electronic messages to 
convey a sense of informality, and to encourage the reader to view the writer as 
a friendly and helpful person.

To insert an emoticon into a Web collaboration message:

1. In the Contact Details window, on the Session tab, click the Emoticon 
button .

2. In the list, select an emoticon. The emoticon is inserted at the cursor position.

NOTE: As a shortcut, you can insert an emoticon by typing the shortcut that is 
shown in the list of emoticons.

6.3.4  Inserting a URL into a Web collaboration 
message

You can insert a URL (Uniform Resource Locator) into a Web collaboration 
message that you are creating. When the contact receives the message, the URL 
appears as a clickable link. The contact can click the URL link and go to the 
specified Web page.

To insert a URL into a message:

1. In the Contact Details window, on the Insert menu, click URL.

2. In the Insert URL dialog box, select a URL.

3. Click the Insert button. The URL is inserted into the work area, at the cursor 
position.

NOTE: As a shortcut, you can click Insert URL on the toolbar above the work 
area, and then select the URL from the list. 
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6.3.5  Inviting another user to join a Web collaboration 
session

You can invite another user to join an ongoing Web collaboration session. When 
a user receives an invitation to join a session, the complete transcript of the 
session appears on his or her screen, up to the point where the invitation was 
sent. The user can review the transcript and then accept or decline the invitation.

To invite another user to join a Web collaboration session:

1. In the Contact Details window, on the Actions menu, click Invite User.

2. In the Invite User dialog box, select a user to invite to join the session. The 
Agents tab and the Team List tab show all the users in the contact center 
and on your team, respectively, who are logged on to Web collaboration and 
are not currently handling a Web collaboration session.  

3. Click OK.

6.3.6  Asking the contact for a telephone number

Use the Call Me feature to ask the contact for a telephone number. Some contacts 
might prefer a telephone conversation in addition to, or instead of, a Web 
collaboration session. The Call Me feature sends a special form to the contact's 
screen. The form contains a place to enter a telephone number, as well as a 
Refuse button. To use the Call Me feature, you must be logged on to an extension 
(that is, logged on to either voice or callback).

When the contact sends a telephone number, if you are not available to call the 
contact (for example, you are now handling a direct call or you are no longer 
logged on to an extension) a message appears, telling you that the contact sent 
a telephone number and is waiting for your call.

To ask the contact for a telephone number:

1. In the Contact Details window, on the Actions menu, click Call Me. A 
message is sent to the contact, asking for a telephone number. 

2. When the contact sends a telephone number, the New Call dialog box 
appears on your screen. Use the New Call dialog box to complete the call. 
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6.4  Disconnecting from a Web collaboration session

When you finish handling a Web collaboration contact, you can disconnect from 
the session.

• If you are the only user talking to a Web collaboration contact, the session 
ends when you disconnect.

• If you are in a conference session with the Web collaboration contact and 
another user, the session continues when you disconnect.

To disconnect from a Web collaboration session:

• In the Contact Details window, on the Actions menu, click Disconnect.

6.5  Wrapping up a Web collaboration session

Use the Wrap-up tab in the Contact Details window to enter Wrap-up reasons, to 
show how you completed a Web collaboration session. 

If the Wrap-up reason required setting is enabled for you in the Manager 
application, you must select at least one Wrap-up reason. 

IMPORTANT: You do not have to wait until you finish handling the contact to 
enter Wrap-up reasons. You can select one or more Wrap-up reasons at any 
time. However, do not save the Wrap-up reasons until you have completed the 
contact, because you can perform only one Save action for Wrap-up reasons. 
After the Save action, you cannot enter any more Wrap-up reasons. 

To wrap up a Web collaboration session:

1. In the Contact Details window, click the Wrap-up tab.

2. Select the check box for each Wrap-up reason that applies to the contact. 
Only Wrap-up reasons that are associated with the contact's queue are 
available. 

3. On the File menu, click Save.
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7  Collaborating with other users

This chapter provides an overview of how to use the Speed List and the Team List 
to help you collaborate with other users. 

7.1  Working with the Speed List

The Speed List is your personal, online contact list. The Speed List is a 
convenient place to store information about people whom you contact frequently, 
and to make it easy for you to contact them. The Speed List can hold a maximum 
of 100 entries. 

Every entry in the Speed List must have a minimum of one telephone number or 
e-mail address associated with it. Web collaboration contacts cannot be added to 
the Speed List.

The Speed List can be accessed from the View menu in the main window, and 
from the View menu in most other Client Desktop windows.

To display the Speed List:

• On the View menu, click Speed List. 

7.1.1  Adding an entry to the Speed List

Use this procedure to add a new entry to the Speed List. Each entry must have 
at least one telephone number or e-mail address. 

If another Client Desktop window already has an entry for this person, you can 
add that entry directly to the Speed List. For more information, see Adding an 
entry to the Speed List from another contact list.

To add an entry to the Speed List:

1. In the main window, on the Actions menu, click New Speed Entry.

2. In the Speed Entry dialog box, in the Name box, type the name of the new 
contact.

3. To enter a telephone number, click in the Home, Office, or Mobile box, and 
then click  to open the Dial Entry dialog box. In the Dial Entry dialog box, 
enter the required information, and then click OK. 

4. To enter an e-mail address, in the Home e-mail box or Office e-mail box, 
type the e-mail address.
A31003-S2281-G101-4-7631
OpenScape Contact Center Enterprise V8 R2, Client Desktop Getting Started Guide 47

        

, May 2012



Collaborating with other users

Working with the Speed List
5. In the Default box, select the telephone number or e-mail address to use as 
the default contact method when you click the person's name on the Speed 
Bar. 

6. Click OK.

7.1.2  Adding an entry to the Speed List from another 
contact list

You can add an entry to the Speed List from any of the following:

• Team List – The team member must be logged on to either voice or callback. 
This ensures that there is an extension number associated with the team 
member.

• Activity Log 

• Ongoing Activity Log

• Directory Search (Results tab) – There must be at least one telephone 
number or e-mail address associated with the entry.

• Contact Details window .

Only entries that have an associated telephone number or e-mail address can be 
added to the Speed List. Web collaboration contacts cannot be added to the 
Speed List. 

To add an entry to the Speed List from another contact list:

1. Open the window that contains the contact to be added.

2. Click the entry. (This step is not necessary in the Contact Details window.)

3. On the Actions menu, click Add to Speed List.

7.1.3  Searching for an entry in the Speed List

When there are many entries in the Speed List, or when not all the columns of 
information are displayed, you can use the search tool to help you find a particular 
entry. 

The results of a search are displayed on the Results tab. You can take the same 
actions for an entry on the Results tab as you can take on the Speed List tab. For 
example, you can contact an entry by telephone or e-mail.
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To search for an entry in the Speed List:

1. In the Speed List, on the Tools menu, click Find. The Look For and Search 
In boxes appear below the standard toolbar. 

2. In the Look For box, type any information that you have about the entry (for 
example, all or part of a name, telephone number, or other attribute of the 
contact). You can enter words in uppercase or lowercase. The search tool is 
not case sensitive.

3. In the Search In box, select Speed List.

4. Click . The Results tab appears, displaying all the entries that were found.

7.1.4  Calling a person in the Speed List

You can call a person in the Speed List, provided that there is at least one 
telephone number associated with the Speed List entry. To call a person in the 
Speed List, you must be logged on to an extension (that is, logged on to either 
voice or callback).

To call a person in the Speed List:

1. In the Speed List, click the entry that you want to call.

2. On the Actions menu, point to Call, and then click the number to dial.

3. In the New Call dialog box, complete the call.  

7.1.5  Sending an e-mail message to a person in the 
Speed List

You can send an e-mail message to a person in the Speed List, provided that 
there is at least one e-mail address associated with the Speed List entry. To 
create a new e-mail message, you must be logged on to e-mail. If you are 
handling an existing message or if there is a new message waiting on your 
screen, you must complete this message before starting a new e-mail message.

To send an e-mail message to a person in the Speed List:

1. In the Speed List, click the entry that you want to send an e-mail message to.

2. On the Actions menu, point to E-mail and then click the address to use. 

3. In the Contact Details window, enter the details of the e-mail message. 
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7.1.6  Viewing the details of an entry in the Speed List

You can configure the appearance of the Speed List (for example, by selecting 
only certain columns to display). Regardless of the columns that are displayed, 
you can always view all the details of an entry in the Speed List. 

To view the details of an entry in the Speed List:

1. In the Speed List, click the entry whose details you want to view.

2. On the Actions menu, click Open Speed Entry.

7.2  Working with the Team List

The Team List displays information about the members of your team. A 
supervisor or manager configures your team in the Manager application. You 
might want to check the Team List before you contact another team member for 
information or assistance. 

The Team List can be accessed from the View menu in the main window, and 
from the View menu in most other Client Desktop windows.

To display the Team List:

• On the View menu, click Team List.

7.2.1  Searching for an entry in the Team List

When there are many entries in the Team List, or when not all the columns of 
information are displayed, you can use the search tool to help you find a particular 
entry. 

The results of a search are displayed on the Results tab. You can take the same 
actions for an entry on the Results tab as you can take on the Team List tab. For 
example, you can contact an entry by telephone.

To search for an entry in the Team List:

1. In the Team List, on the Tools menu, click Find.

Two boxes (Look For and Search In) appear below the standard toolbar.

2. In the Look For box, type any information that you have about the entry (for 
example, all or part of a name, telephone number, or other attribute of the 
contact). You can enter words in uppercase or lowercase. The search tool is 
not case sensitive.

3. In the Search In box, select Team List.

4. Click . The Results tab appears, displaying all the entries that were found.
 A31003-S2281-G101-4-7631, 
50 OpenScape Contact Center Enterprise V8 R2, Client Desktop Getting Started Guide

        

May 2012



Collaborating with other users

Working with directories
7.2.2  Calling a person in the Team List

When you want to call a member of your team, the information that is displayed 
in the Team List can help you decide whether it is a good time to call that person. 
For example, you can see whether the team member is currently handling a 
contact, and how many contacts are waiting for the team member. 

Both you and the team member must be logged on to an extension (that is, logged 
on to either voice or callback).

To call a person on the Team List:

1. In the Team List, click the entry that you want to call.

2. On the Actions menu, point to Call, and then click the person's telephone or 
extension number. The call is automatically dialed for you.

7.2.3  Viewing the details of an entry in the Team List

You can configure the appearance of the Team List (for example, by selecting 
only certain columns to display). Regardless of the columns that are displayed, 
you can always view all the details of an entry in the Team List.

To view the details of an entry in the Team List:

1. In the Team List, click the entry whose details you want to view.

2. On the Actions menu, click Open Team List Entry.

7.3  Working with directories

You can use the directory feature to search external directories and databases in 
real time (for example, your company's directory or another external directory 
service). This is helpful when you need to contact colleagues and customers who 
are outside the contact center.

A manager or supervisor uses the Manager application to give you access to the 
directory. In addition, the manager or supervisor configures the fields that you can 
use as the search criteria and the fields that display the results of the search. 

The directory might contain the following information:

• Name of the person.

• Home, office, or mobile telephone number.

• Home or office e-mail address.

• Other information (for example, department, title, or specialty).
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7.3.1  Searching a directory

The Directory Search window is a convenient tool for querying a directory 
(searching for specific entries) and for using the results of the search. Directory 
searches are real-time searches. The specified directory is searched immediately 
and the results of the search appear in a short time. 

The Directory Search window has two tabs:

• Query tab – The Query tab is used to enter the search criteria. The fields that 
you can use as the search criteria are configured in the Manager application. 
For example, a Name field is commonly used to search a directory. You can 
use the Client Desktop application to configure the settings of the directory 
search fields, to make your searches easier. 

• Results tab – The Results tab displays the results of a directory search. The 
type of information that is displayed on the Results tab depends, first, on how 
the result fields are configured in the Manager application, and second, on 
how you configure the result fields in the Client Desktop application. 

NOTE: To perform a directory search, the Directory permission must be 
enabled for you in the Manager application, and your connection settings for the 
directory must be properly configured. 

You can start a directory search in one of the following ways:

• Searching a directory using the Directory Search window

• Searching a directory using the Quick Search toolbar

Regardless of how you start the search, the results of the search are displayed 
on the Results tab of the Directory Search window. You can take a variety of 
actions against the entries on the Results tab in the Directory Search window.
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7.3.1.1  Searching a directory using the Directory Search 
window

You can search a directory using the Directory Search window.

To search a directory using the Directory Search window:

1. Open the Directory Search window by doing one of the following:

• On the View menu, click Directory Search.

• On the toolbar, click the Directory Search button .

2. Under Criteria, in the Directory list, select the name of the directory that you 
want to search. 

3. Narrow the search by entering any search criteria that you know in the 
appropriate box. For example, you can enter the name, telephone number, or 
e-mail address of the entry that you are looking for. If you know only part of a 
name, telephone number, or e-mail address, you can enter that part.

4. Click  Find Now. The Results tab opens, displaying all the entries that 
were found.

7.3.1.2  Searching a directory using the Quick Search toolbar

You can search a directory using the Quick Search toolbar in the Contact Details 
window. 

NOTE: If the Quick Search toolbar is not displayed in the Contact Details 
window, on the Tools menu, click Customize, click the Toolbars tab, and then 
select the Quick Search check box. 

To search a directory using the Quick Search toolbar:

1. In the Contact Details window, on the Quick Search toolbar, in the 
Directory Query box, type or select the information that you know about the 
entry you are looking for. 

2. In the Search In list, select the field that you want to search in.

3. In the Directory list, select the name of the directory that you want to search.

4. Click . The Directory Search window opens to the Results tab, displaying 
all the entries that were found. 
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7.3.2  Calling a person in a directory

When you use the Directory Search window to conduct a search, you can call an 
entry that appears on the Results tab, provided that there is a telephone number 
associated with the entry. For details about conducting a directory search, see 
Searching a directory.

NOTE: The Client Desktop application supports one-step calling for certain 
telephone numbers. These numbers are identified on the Call submenu by a 
shortcut, for example, Ctrl+F4, beside them. When you click the number or press 
the shortcut keys, the Client Desktop immediately dials the number.

To call a person in a directory:

1. In the Directory Search window, on the Results tab, click the entry that you 
want to call. 

2. On the Actions menu, point to Call, and then click the person's telephone or 
extension number. The call is automatically dialed for you.

7.3.3  Creating a callback for a person in a directory

When you use the Directory Search window to conduct a search, you can create 
a callback for an entry that appears on the Results tab, provided that there is a 
telephone number associated with the entry. For details about conducting a 
directory search, see Searching a directory.

To create a callback for a person in a directory:

1. In the Directory Search window, on the Results tab, click the entry for that 
person.

2. On the Actions menu, point to Callback, and then click the number to use to 
create the callback. The Contact Details window appears. In the lower part of 
the window, you can see the first Schedule item, which the system 
automatically creates for you.

3. In the Contact Details window, enter the details of the new callback. 
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7.3.4  Sending an e-mail message to a person in a 
directory

When you use the Directory Search window to conduct a search, you can send 
an e-mail message to an entry that appears on the Results tab, provided that 
there is an e-mail address associated with the entry. For details about conducting 
a directory search, see Searching a directory.

To create a new e-mail message, you must be logged on to e-mail. If you are 
handling an existing message or if there is a new message waiting on your 
screen, you must complete this message before starting a new e-mail message.

There are two ways to send an e-mail message to a person in a directory:

• Using the directory entry.

• Using the Directory List Entry dialog box.

To send an e-mail message to a person in a directory:

1. Find the person whom you want to send an e-mail message to.

2. In the Directory Search window, on the Results tab, click the entry to send 
the e-mail message to.

3. Do one of the following:

• On the Actions menu, point to E-mail and then click the address to use.

• On the Actions menu, point to Open, and then in the Directory List 
Entry dialog box, click  beside the e-mail address to use.

4. In the Contact Details window, enter the details of the message. 
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